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Chapter 1. Overview

Love it or hate it, electronic mail has become an effective form of communication
widely used in our private lives and dealings with businesses, governments, and
other organizations. The trend towards on-line purchasing, investments, banking,
managing utilities and tax returns is driving further adoption of email. For example
customers now expect confirmation of orders, account alerts, and availability of
statements to be sent within minutes via email.

As many of today's transactions are hosted in CICS Transaction Server (CICS), it
is not surprising the need to send emails from CICS applications has been raised a
number of times on the cics-l list and customer surveys.

There are already a number of solutions to send emails from CICS and batch, such
as the z/OS Communications Server SMTP application and the spool interface,
intermediaries such as process servers, and writing your own SMTP client. These
solutions however can be inflexible in creating the email content, lack immediacy,
require in-depth knowledge of SMTP, require code to be developed and
maintained, or require the purchase of additional products.

This SupportPac provides an SMTP client to send emails and attachments that is
quick to setup, easy to call from your CICS application, CICS event, batch JCL or
script. It runs in Java and therefore eligible for off-loading onto a System z

Application Assist Processor (zAAP) specialty engine.

In addition to sending emails, the SupportPac is able to write to CICS temporary
data (TD) queues and temporary storage (TS) queues, submit MVS jobs, issue
MVS console messages, and send HTTP requests. TD queues can be used as an
audit trail or monitored by systems management tools to initiate automation scripts.
TS queues are useful to test the capture, emission and formatting of events. MVS
jobs and console messages can be used to automate system activity, issue modify
commands, or initiate batch work. HTTP requests could initiate many types of
activity such as sending SMS messages or updating dashboards.

Sending an email from CICS

Overview

This SupportPac provides a choice of two interfaces to send an email from CICS.
1. Capture an event and emit it to the SupportPac event adapter.

» Use the CICS Explorer event binding editor to define when and what
information to capture from your application or system event.

You can also use the CICS Explorer policy definition editor to define
policy actions that you want to emit as a system event.

« Use the CICS Explorer event adapter editor to define SupportPac
transaction CA1Y as the custom event adapter and specify the email
headers, content, attachments, etc. using name=value properties.

» This interface is unlikely to require changes to the application, and
because it can process the event asynchronous it is unlikely to
change the applications' response time or qualities of service.

e This is the recommended approach.

2. Write an application to call the SupportPac.

»  From your application, create one or more CICS containers to
specify the email headers, content, attachments, etc., then issue a
LINK CHANNEL command to program CA1Y, or START CHANNEL
command to transaction CA1Y.

Alternatively, you can use a CICS communications area (commarea)

or START FROM area instead of a container, but these are restricted
in size to less than 32KB and the content are required to be encoded
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using the CICS region local CCSID in which CA1Y executes.

* The LINK CHANNEL and LINK COMMAREA commands will
synchronously send an email from an application. Your application
will wait for the email to be sent and could react if there is an error.

* The START CHANNEL command will asynchronous send an email
from an application. CICS will schedule the CA1Y transaction for
execution and your application will not be aware of the success or
failure of the request.

Both of these interfaces are easy to use and flexible, allowing you to specify:

Email address headers for recipients including; from, to, carbon copy
(cc), blind carbon copy (bcc), and reply to. These headers are specified
using the Internet Engineering Task Force (IETF) REC 822 format, for
example; <sam.smith@company.com>,

“John Doe” <j.doe@example.com>

Email subject formatted as a single line of plain text.
Email content typically formatted as plain text or HTML.

Email attachments including a name and Multipurpose Internet Mail
Extensions (MIME) type as defined by REC 2046 and IANA. For example
photos, Portable Document Format (PDF), or spreadsheets could be
attached. The SupportPac can compress attachments into a zip to save
network bandwidth and mail server storage.

Tokens placed anywhere in the subject, content and other properties are
automatically replaced with CICS event information items, current time &
date, CICS containers, DOCTEMPLATE resources, MVS files, or zFS files.
This token replacement is similar in concept to mail merge in word
processors and mass mail systems.

Conversion of content and attachments from XML into other document
types. The SupportPac processes the XML in combination with your XML
stylesheet (XSLT) to generate HTML, XHTML, or other XML documents. In
addition the SupportPac can work in combination with the open source
Apache™ FOP Project (Formatting Objects Processor) to convert XSL
formatting objects (XSL-FO) into PDF, Rich Text Format (RTF), and other
printed documents. For example this enables CICS event information to be
combined with other XML and a stylesheet to create an invoice in PDF
format that is emailed to a customer.

SMTP server configuration including IP name or address, IP port, and
security credentials.

Importing of common configuration from zFS and other locations
enabling SMTP server configuration to be secured and managed separate
to the application.

The following figure shows how the SupportPac can receive requests from a
variety of application and system events and from applications issuing LINK
commands. The requests are sent using SMTP to any mail server on any platform,
ready for retrieval by an email client, or relaying on to external email systems.
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Software requirements

Restrictions

What's new

Overview

To use the SupportPac in CICS, you must have one of the following versions of
CICS installed and configured to use the Java server environment;

» CICS Transaction Server for z/OS V4.2 or later
» CICS Transaction Server for z/OS Developer Trial
» CICS Transaction Server for z/OS Value Unit Edition

To use the SupportPac in batch, any supported version of IBM 31-bit SDK for z/OS,
or IBM 64-bit SDK for z/OS is required.

To send emails the JavaMail™ API is required. Although a version is provided with
CICS TS, to use the latest version, or to use the SupportPac in batch, download
the JavaMail API from their project site.

To create PDF documents, the Apache FOP Project is required.

The SupportPac uses the JavaMail API to interact with the mail server. The
SupportPac has been tested with the Simple Mail Transfer Protocol (SMTP) service
provider. The JavaMail API provides additional protocol service providers such as
IMAP and POP3 that may work, but they have not been tested.

Version 1.7.0 released February 2016

* New support to call the SupportPac from a z/OS JCL batch job, a USS
script, or using the CICS command START FROM().

New texttable token will create a hexadecimal dump of the conents of
all properties and containers, or only those whos name matches a
specified regular expression. The htmltable token provides similar data
but in an HTML table form suitable for use in an email.

» Fix to set the email header time and date to the CICS local time and date
(ABSTIME) when the event was captured. If you wish to set an alternative
date and time, set the new mail.sentdate property.


http://xmlgraphics.apache.org/fop/
http://xmlgraphics.apache.org/fop/
http://java.net/projects/javamail/pages/Home
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http://www.ibm.com/software/htp/cics/cicsdt/
http://www.ibm.com/software/products/en/cics-tservers

Version

Version

Version

Version

Fix to not issue an abend when CICS is unable to capture a data item. For
example if your event binding specified a FILE ENABLE STATUS system
capture point and made use of DSNAME, but the file resource did not
specify a data set name then DSNAME will not be captured.

1.6 released February 2014

New support for specifying properties in a CICS commarea.

New support to read JVM system properties.

Optimization to reduce the number of JNI calls to get CICS containers.

The property mail.propstable has been replaced with token
htmltable to allow it to be used in more situations.

Fixes to allow UTF-8 characters in the mail subject and content, and to
allow emails to be sent when there is a subject but no content.

Fix to not overwrite a property alternate name with a container name.
1.5 released December 2013

New support to link to a CICS program with the current channel using the
1link token.

New support to copy the data from a property into a container using the
putcontainer token.

New support for using the Saxon XSLT and XQuery processor to transform
XML into another XML or xHTML document.

New support to send an HTTP request using the http.content property
that provides options to retry after network failures.

New support to LINK to a CICS program if there is a failure to process the
request using the onfailure property.

New commonbaseevent, commonbaseeventrest, and json tokens to
create XML and JSON documents that represent a CICS event.

New nomoretokens and noinnertokens tokens to avoid unnecessary
searching for tokens in large properties.

Fix. In V1.3 and V1.4 when a file token was used to read an MVS file it
remained open until the JYMSERVER was disabled. In V1.5 the file is
closed after being read.

1.4 released September 2013
New support to submit an MVS job using the mvsjob.content property.

New support to issue an MVS console message using the
mvswto.content property.

New support to get files from an FTP server using the ftp token.

New support to insert z/OS system symbols using the systemsymbol
token.

New support to insert a hexadecimal representation of a property using the
hex token.

name token can now set the name of a property to the value of another
property, useful to dynamically name attachments. For example, you can
include a date stamp in the name.

1.3 released May 2013

New support to read sequential datasets and partitioned datasets (PDS)
using tokens file=//"'dataset' and file=//DD:ddName.

CICS SupportPac CA1Y - Installation and User's Guide



Overview

Version

Version

Version

New support to compress one or more properties into a zip file using
tokens zip=zipFilename and
zip=zipFilename:include=propertyList

New support to write content to a TD or TS queue using the queue
properties.

New support to transform application data into XML using the CICS
XMLTRANSFORM resource with the token
transform=property:xmltransform=resource.

Added example logging properties.
1.2 released April 2013

New support to read DOCTEMPLATE resources using the doctemplate
token.

Fix for error “java.lang.NoSuchMethodError:
com/ibm/cics/server/Container.putString(Ljava/lang/Stri
ng; )” when using LINK to call SupportPac V1.1 with CICS TS V4.2.

1.1 released February 2013

New support for converting XSL Formatting Objects (XSL-FO) into PDF or
other print documents. This support requires the Apache FOP Project.

New support for converting XML using XSLT (Extensible Stylesheet
Language Transformations) into other document types.

New support for returning properties to the application using the token
returncontainer. For example the application can use the SupportPac
to generate a PDF that is returned to the application for archiving or
returning to a client.

The MIME type for mail contents and other properties is now set using
token mime. The properties mail.contentmime andmail.attmime.n
from version 1 are no longer used.

A property is now automatically attached to the email if it includes the mime
token. The property mail.att.n from version 1 is no longer used to
specify email attachments.

A property is now named using the name token. The property
mail.attname.n from version 1 is no longer used.

Log messages are now written using the Java SE java.util.logging package
for greater flexibility to select the log records of interest, directing log
records to sets of files, and integration with other Java applications.

The property mail.log.success from version 1 is no longer used. When
an email is successfully sent a log record is written if the log level is set to
INFO.

The property mail.log. fail from version 1 is no longer used. When a
failure occurs a log record is written if the log level is set to WARNING.

The properties 1og.tokens and 1log.epconversions from version 1.0
are no longer used. The processing of tokens and adding event processing
information items are written if the log level is set to FINE.

1 released October 2012
Support for sending emails and attachments.


http://docs.oracle.com/javase/7/docs/api/java/util/logging/package-summary.html
http://xmlgraphics.apache.org/fop/

Feedback

This SupportPac is provided as-is and is not supported by IBM service. However
the author welcomes your comments and bug reports by email to

mark_cocker@uk.ibm.com or by appending to the CICS developer center Q&A.

For new features please submit a Request For Enhancement and select; brand as
WebSphere, product family as Transaction Processing, product as CICS
Transaction Server, and component as Other.

CICS SupportPac CA1Y - Installation and User's Guide
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Chapter 2. Installation

The following tasks guide you through downloading and installing the SupportPac,
configuring CICS, and optionally installing the Apache FOP and Saxon projects.

The tasks assume you are familiar with managing CICS resources, zFS files, and
z/OS UNIX commands, and that the software requirements mentioned on page 5 are

installed.

Download, copy and decompress the SupportPac

From a workstation:

1.
2.

Use a browser to navigate to the SupportPac CA1Y site.

Download caly.zip by clicking the appropriate link under Download
package.

Providing you agree to the terms and conditions shown, click | agree.
Save the file caly.zip.

Create an installation directory on zFS for the SupportPac, for example
/usr/lpp/caly, and copy caly.zip in binary into it.

From a z/OS UNIX shell:

1.

Decompress caly.zip into the zFS installation directory, for example:

mkdir /usr/lpp/caly

cd /usr/lpp/caly
jar xvf caly.zip

Decompress the .jar file. This is only required to use the SupportPac in
batch, for example from a shell script, as the JVM outside of CICS does
not provide an OSGi framework.

jar xvf com.ibm.cics.caly 1.7.0.jar

Set the permissions for the installation directory and the files contained in them,
ensuring in particular the CICS default user ID has read access to the file
/usr/lpp/caly/com.ibm.cics.caly 1.7.0.Jjar

Update the CICS JVM server profile

The SupportPac is written in Java and requires a CICS JVM server configured with
two OSGi bundles.

Installation

1.

If you do not already have a CICS JVMSERVER resource and JVM profile
with OSGi support, follow the guidance in topic Configuring a JVM server
for an OSGi application in the CICS Knowledge Center to create and
configure them.

Modify the OSGI_BUNDLES property in the JVM profile to include the
JavaMail file mail.jar supplied with CICS, and the SupportPac .jar file. For
example:

OSGI_BUNDLES=/CICS install dir/lib/pipeline/mail.jar,/usr/lpp
/caly/com.ibm.cics.caly 1.7.0.Jjar

Replace CICS install dir with the path of the CICS installation.

Note: CICS TS V4.2 and V5.1 provide JavaMail version 1.4.3. Later
versions are available from Java.net that contain fixes and enhancements.
As of JavaMail version 1.5, the file name was changed from mail.jar to
javax.mail.jar. If you decide to use this version, upload it to zFS and
specify its location on the OSGI_BUNDLE property and remove reference
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to the CICS provided version.

3. Install the JVMSERVER resource and ensure it is enabled. The OSGi
bundles will be installed as part of enabling the JVM server.

4. Optionally, add the JYMSERVER resource to a group in the CICS startup
list so it will be installed automatically when CICS is next started using
COLD or INITIAL options.

Define and install CICS resource definitions

The SupportPac requires a PROGRAM and a TRANSACTION resource to be
installed in the CICS region in which either the events will be captured, or your
applications will issue the LINK or START commands to send an email.

1. Define a PROGRAM resource with the following attributes, replacing
DFH$JVMS with the name of the JVMSERVER resource installed
previously:

o Name: CAlY

o Group: CALlY

o Description: CICS SupportPac CAlY program
o JVM: Yes

o JVMclass: com.ibm.cics.caly.Emit

o JVM server: DFHSJVMS

o Data location: ANY

o Concurrency: THREADSAFE

2. Define a TRANSACTION resource with the following attributes. The
transaction must be a local transaction as per topic Custom EP adapter.
You may receive warnings saying transaction IDs starting with “C” are
reserved for CICS. These can be ignored or choose a different ID.

o Name: CcAly
o Group: CALlY
o Description: CICS SupportPac CAlY transaction
o Program: CAlY
o Task data location: ANY
o Dynamic: NO
Install group CALY.

Optionally, add group CA1Y to a CICS startup list so these resources will
be installed automatically when CICS is next started using COLD or
INITIAL options.

Optionally create an email server properties file

10

In order for the SupportPac to connect to the mail server you need to provide
information such as the server host name and port, and credentials such as a
userid and password.

It is recommended you create a properties file on zFS with this information so it can
be managed and secured separate to application artifacts such as event adapter
configurations, event bindings, or programs. This file can then be read at runtime
by specifying an import token as shown in the examples in later chapters.

CICS SupportPac CA1Y - Installation and User's Guide
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Copy the example properties file
/usr/lpp/caly/examples/emailServer.properties to a suitable
directory.

Edit the new properties file to specify your mail server SMTP information.
Note this file is supplied in UTF-8 format, but you could choose to use an
EBCDIC format if required. The properties allowable in this file are
described in SMTP mail properties on page 30.

It is likely the SMTP server will be located within your company network.

The SupportPac will communicate with the SMTP server using a TCP/IP

socket from the JVM server to send the email, therefore ensure there are
no firewall rules in place that prevent this access.

For illustration purposes only, examples are included for Google Gmail,
Yahoo! Mail Plus, Microsoft Windows Live and Hotmail. The author does
not endorse these services, nor implies usage of them meets the terms
and conditions from the service providers.

Some mail providers such as Google Gmail require the user ID used to
send the email is setup to enable SMTP access.

Set the permissions of this file such that only the user ID under which the
SupportPac is going to be run has read access, and security administrators
have read and write access. To set the user ID under which the
SupportPac will run, use the options in the CICS event processing event
adapter configuration.

Optionally install Apache Formatting Objects Processor (FOP)

Apache FOP V1.1 or later is only required if you need to transform XML to a PDF,
PS, AFP, RTF, PNG or another format. Use the following steps to download the
project, package it into an OSGi plugin project, and deploy it into the CICS JVM
server using a CICS bundle.

Installation

Download and unzip Apache FOP:

1.

Download Apache FOP by browsing to

http://xmlgraphics.apache.org/fop/download.html and following the links to
the binary download for FOP 1.1, or later.

Unzip the downloaded file fop-1.1-bin.zip. The directory fop-1.1 will
be created.

Create an OSGi plug-in project to contain Apache FOP:

1.

In CICS Explorer SDK, select File > New > Other > Plug-in from Existing
JAR Archives > Next

Select Add External. Navigate to directory fop-1.1/build and select
fop.jar > 0K

Select Add External. Navigate to directory fop-1.1/1ibs and select all
the jar files > OK

Select Next.

In the "Enter the data required to generate the plug-in." panel, set the
following:

o Project name: org.apache. fop
o Plug-in Version: 1.1.0
o Plug-in name: FOP

o Plug-in Provider: Apache

11
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o Execution Environment: J2SE-1.5

o This plug-in is targeted to run with: an OSGi framework:
Equinox

o Untick Unzip the JAR archives into the project
o Select Finish
Create a CICS bundle project to deploy the OSGi plug-in project to CICS:

1. In CICS Explorer SDK, select File > New > Other > CICS Bundle Project
> Next and set:

° Project name: Apache FOP
° Version: 1.1.0

2. Select the new CICS bundle project, then select File > New > Other >
Include OSGi Project in Bundle > Next > org.apache.fop and set the
following, replacing DFH$JVMS with the name of the JYMSERVER
resource in which the SupportPac was configured to run in:

o JVM Server: DFHSJVMS

o Select Finish

3. Right mouse button on the CICS bundle project then select Export Bundle
Project to z/0S UNIX File System and follow the prompts to export the
bundle project to zFS.

4. Define a BUNDLE resource with the following attributes:
o Name: FOP
o Group: CAlY
o Description: Apache FOP
° Bundle Directory: <directory>/Apache FOP 1.1.0
Install the FOP BUNDLE resource and ensure it is enabled.

You will need to disable, then enable the JVMSERVER resource to ensure
the SupportPac resolves its optional references to this new OSGi project.

Configure the SupportPac to use Apache FOP by adding the following property to
either:

1. The JVM server profile:
-Djavax.xml.transform.TransformerFactory=org.apache.xala
n.processor.TransformerFactoryImpl

2. Or the configuration passed to the SupportPac:
javax.xml.transform.TransformerFactory=org.apache.xalan.
processor.TransformerFactoryImpl

Do not configure Apache FOP and Saxon to run in the same JVM server instance.

Optionally install Saxon XSLT and XQuery processor

Saxon is an open source project that provides an implementation of the XSLT 2.0,
XPath 2.0, and XQuery 1.0 standards, and later working draft versions of those
standards. This is only required if you need to transform an XML source-tree into
an XML result-tree, such as HTML, XHTML, or XML. Use the following steps to
download the project, package it into an OSGi plugin project, and deploy it into the
CICS JVM server using a CICS bundle.

Note: other XSLT processors are available and may work with the SupportPac.

Download and unzip Saxon:

12 CICS SupportPac CA1Y - Installation and User's Guide
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1. Download Saxon by browsing to http://saxon.sourceforge.net/ and
following the links to an appropriate edition and download it. Note the
author has tested with Saxon-HE 9.5, but other editions should work.

2. Unzip the downloaded file, for example SaxonHE9-5-1-2J. zip. Inside
the created directory should be a .jar file, such as saxon9he. jar.

Create an OSGi plug-in project to contain Saxon:

1. In CICS Explorer SDK, select File > New > Other > Plug-in from Existing
JAR Archives > Next

2. Select Add External. Navigate to directory SaxonHE9-5-1-2J and select
saxon%he.jar > OK

6. Select Next.

In the "Enter the data required to generate the plug-in." panel, set the
following:

o Project name: net.sf.saxon

o Plug-in Version: 9.5.1

o Plug-in name: Saxon

o Plug-in Provider: Saxonica

o Execution Environment: J2SE-1.5

o This plug-in is targeted to run with: an OSGi framework:
Equinox

o Untick Unzip the JAR archives into the project
o Select Finish
Create a CICS bundle project to deploy the OSGi plug-in project to CICS:

1. In CICS Explorer SDK, select File > New > Other > CICS Bundle Project
> Next and set:

°  Project name: Saxon

o Version: 9.5.1

2. Select the new CICS bundle project, then select File > New > Other >
Include OSGi Project in Bundle > Next > net.sf.saxon and set the
following, replacing DFH$JVMS with the name of the JYMSERVER
resource in which the SupportPac was configured to run in:

o JVM Server: DFHSJVMS

o Select Finish

3. Right mouse button on the CICS bundle project then select Export Bundle
Project to z/OS UNIX File System and follow the prompts to export the
bundle project to zFS.

4. Define a BUNDLE resource with the following attributes:
o Name: SAXON
o Group: CAlY
o Description: Saxon XSLT and XQuery Processor
o Bundle Directory: <directory>/Saxon 9.5.1./
5. Install the SAXON BUNDLE resource and ensure it is enabled.

You will need to disable, then enable the JVMSERVER resource to ensure
the SupportPac resolves its optional references to this new OSGi project.
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Configure the SupportPac to use Saxon by adding the following property to either:

1. The JVM server profile:

-Djavax.xml.transform.TransformerFactory=net.sf.saxon.T
ransformerFactoryImpl

2. Or the configuration passed to the SupportPac:
javax.xml.transform.TransformerFactory=net.sf.saxon.Tra
nsformerFactoryImpl

Do not configure Apache FOP and Saxon to run in the same JVM server instance.
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Chapter 3. Examples to send an email using the CA1Y
event adapter

The tasks in this chapter assume you work through the examples in the order
presented.

Send an email when the EXMPCAT file changes status

This example shows how to use the CICS Explorer to create an event binding file
that captures a system event, in this case a change status to the file EXMPCAT,
and to send an email containing data from the event.

Import the SupportPac example CICS bundle project into the CICS Explorer:
1. Start the CICS Explorer.
2. Change to the Resource perspective.

3. Select File > Import > General > Existing Projects into Workspace >
Next

Select Select archive file: > Browse

4
5. Navigate to and select the caly.zip downloaded previously > OK
6. Select calyExampleEvents > Finish

7

Expand the calyExampleEvents CICS bundle project.

Resource - Eclipse SDK

File Edit MNavigate Search Project Run Wini

C3- A VR E e &C
&

[+ Project Explorer B

v = calyExampleEvents

* = META-INF

Ex EmailCA1YCOB1.evbind
k5 EmailCatalogStockStatus.evbind
&+ EmailExmpcatEnableStatus.evbind

o= Outline 52 =im

Anoutline is not available.

8. EditEmailExmpcatEnableStatus.evbind to start the Event Binding
editor.

9. Select the Specification tab.

10. In the Emitted Business Information section is a list of fields that will be
passed to the SupportPac event binding adapter. As we will see later, each
of these fields can be inserted into the email.
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i+ EmailExmpcatEnableStatus.evbind 3

E

Check_EXMPCAT_going_d|| Identify and describe the event.
Name

Description Generate an event when the Catalog Stock File goes to the disabled state

Describe and order the business information to be emitted by the event.

Name Type Lengtl Precisior Description ) Add...
(3] File_name Text |8 0 Name of the file

(] Dataset_Name Text | 44
G From_Enable_S Text | 16
3] To_Enable_stat Text | 16
[ Open_Status | Text | 16

Add Capture Specifications to this event.

8 Add a Capture Specification...

Use this to automatically generate a capture specification for a signal event call using the business information entered above.

Event Binding | Specification| Adapter

Catalog_file_disabled_check & Edit...

Name of dataset for file

The file is changing FROM this enable status

The file is changing TO this enable status

The open status of the file when the enable status changed

o o o o

11.
12.

13.

14.

15.

16.

17.

18.

19.

On the left hand pane, select Check EXMPCAT going disabled

Select the Capture Point tab. Notice under the Capture Point section that
this event is for FILE ENABLE STATUS.

Select the Filtering tab. Notice next to FILE* the operator is set to Equals
and value set to EXMPCAT. This file will have been created if you set up the

CICS catalog manager example application. You can change this to the
name of any FILE resource in your system.

Also notice TO_ENABLESTATUS is setto Equals DISABLED. Once
these filter conditions are met the event will be captured by CICS.

Select the Information Sources tab to see how the emitted business
information is obtained — ie. where the data is captured from.

Select the Adapter tab. This is where you define which adapter is to emit
the event and its configuration. Note you can define adapters in separate
configuration files to enable you to share common adapter configurations
across many event bindings. For simplicity it is defined here.

Under the Adapter section, notice Custom (User Written) is
selected. CICS provides a number of adapters to send the event via a
WebSphere MQ message, to an HTTP server, etc. but we are going to call
the SupportPac transaction CA1Y that was installed previously in Define
and install CICS resource definitions on page 10.

The area under Data passed to the Custom Adapter is where you
configure how the SupportPac should process this event. The properties
are formatted as name=value pairs and are detailed in Properties on page
29.

The import property loads further properties from a file on zFS. Change
the file path and name to match the mail server properties file created
earlier as part of Optionally create an email server properties file on page
10. Alternately you could remove this import and define them all here.

Change the mail. to property to your email address.
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20. Notice the mail.content property uses tokens to embed the business
information items. The SupportPac will process the tokens and replace

them when the email is prepared. The valid tokens are listed in Tokens on
page 37.

21. Save the event binding and close the editor.

- EmailExmpcatEnableStatus.evbind 3 =&
E Adapter @

~ Resource

Use a predefined EPADAPTER or EFPADAPTERSET resource, or use an adapter that you specify here.
Use a predefined EPADAPTER resource
Use a predefined EPADAPTERSET resource

@® Use an adapter defined here

~ Adapter
Choose the adapter and settings to emit events.

Adapter | Custom (User Written)

Emits events in any format that you require. A custom EP adapter is a CICS program that you write to provide a combination of fo
adapter must not carry out any other processing, such as consumption of the event.

TransactionID |CA1Y

Data passed to the Custom Adapter

import={file=/usr/|pp/caly/examples/emailServer.properties:encoding=UTF-8}
mail.to="Joe Adventurous" <user@example.com>
mail.subject=Event from CICS TS

mail.content=CICS file {File_name}, Dataset {Dataset_Name}, changed enable status from {From_Enable_Status} to {To_Enable_Status}. O

Event Binding | Specification | Adapter

Deploy this CICS bundle to zFS and install it:

1. With the mouse positioned over the calyExampleEvents project, use
the right mouse button and select menu item z/OS UNIX File System as

Bundle Project. Follow the wizard to deploy the project to a directory on
zFS.

2. Create a BUNDLE resource and set the following:
o Name: CA1YEXAM
o Description: SupportPac CAlY example events
o Bundle Directory: <zFS directory>

3. Install the BUNDLE resource and check it is enabled.

CICS will now capture the event when the status of file EXAMPCAT changes to
disabled, and emit the event to the SupportPac that will send it as an email.

If the email does not arrive check Troubleshooting on page 45.
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Send an email when ordering from the catalog manager application

This example sends an email from the CICS provided catalog manager application
when it issues a REWRITE command to update the VSAM file EXMPCAT,
providing the stock levels are less than 24 and the value of back orders is 0.

Setup the application and customize the event:

1. Setup the CICS catalog manager example application provided with CICS
TS.

2. Use the CICS Explorer to expand the calyExampleEvents project and
edit EmailCatalogStockStatus.evbind.

Select the Adapter tab.

4. The import property loads further configuration from a file on zFS.
Change the file path and name to match the mail server properties file
created as part of Optionally create an email server properties file on page
10.

Change the mail. to property to your email address.

Notice the mail.content property is loaded from the file
/usr/lpp/caly/examples/emailTemplate.html. You can use the
CICS Explorer z/OS perspective, view z/OS UNIX Files, to navigate to this
directory and edit the file.

Save the event binding and close the editor.
Deploy the updated calyExampleEvents project to zFS.
If the BUNDLE resource CA1YEXAM is currently enabled:
o Disable BUNDLE CA1YEXAM.
o Discard BUNDLE CA1YEXAM.
10. Install BUNDLE CA1YEXAM.
You are now ready to run the CICS catalog application.
1. Ata 3270 terminal, run transaction EGUT.
2. Choose the action List items.
3. Select an item in the list to order.
4

Take note of Stock and On Order quantities. The event will only be
captured when you raise an order and the stock level is below 24 and the
On Order quantity is 0. You may need to make more than one order to
achieve this state.

Once an order is made that matches the filter, you should receive an email.

Send an email when a program issues a SIGNAL EVENT

The example COBOL program CA1YCOB1 creates two containers with data, one
with customer data and another with order information. The program then issues a
SIGNAL EVENT command. An excerpt of the program is below:

Identification Division.
Program-id. CA1YCOB1.
Environment division.
Data division.

KA R A AR A AR A KRR A A A AR AR A A A A IR A A R A A I A A A A A I A A A A AR A A kA A Ak kA Ak kA khk

Working-storage section.

01 EVENT PIC X(32) VALUE 'OrderPlaced '
01 CHANNEL-INFO.
02 EVENT-CHANNEL PIC X(16) VALUE 'MyChannel '
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02 CONTAINER-CUSTOMER PIC X(16) VALUE 'Customer .
02 CONTAINER-ORDER-PLACED PIC X(16) VALUE 'Order '
01 CUSTOMER.

02 CUST-NAME PIC X (20) VALUE 'Joe Adventurous '

02 CUST-ADDR1 PIC X (20) VALUE 'Rockclimbing Avenue '.

02 CUST-EMAIL PIC X (20) VALUE 'user@example.com '
01 ORDER-PLACED.

02 ORDER-NUMBER PIC 9(08) VALUE 12345678.

02 ITEM-QUANTITY PIC 9(03) VALUE 1.

02 ITEM-DESCRIPTION PIC X(20) VALUE 'Rope '

KA A AR A AR AR A A A A AR AR A A A A AR AR A IR A A I A AR AR A A A A A A AR A A A A A AR A A A Ak kA ko k%

Linkage section.
Procedure division.
Main-program section.

EXEC CICS PUT CONTAINER (CONTAINER-CUSTOMER)
CHANNEL (EVENT-CHANNEL)
FROM (CUSTOMER) CHAR

END-EXEC.

EXEC CICS PUT CONTAINER (CONTAINER-ORDER-PLACED)
CHANNEL (EVENT-CHANNEL)
FROM (ORDER-PLACED) CHAR

END-EXEC.

EXEC CICS SIGNAL EVENT (EVENT)
FROMCHANNEL (EVENT-CHANNEL)
END-EXEC.

EXEC CICS RETURN END-EXEC.

Use the following steps to edit, compile and install the program:
1. Copy the program source from /usr/lpp/caly/examples/CA1YCOB1
to a COBOL source data set.

For example in a UNIX System services shell to convert the source to IBM-
1047 code page and copy it to the data set HLQ.CA1Y.COBOL.:

cd /usr/lpp/caly/examples
iconv -f IS08859-1 -t IBM-1047 CA1YCOB1 > CA1YCOB1.E
cp CA1YCOB1.E "//'HLQ.CA1lY.COBOL (CA1YCOBI1)'"

2. Edit the program source and change the value of field CUST-EMAIL to be
your email address.

3. Ensure that special characters, such as @ { } () in the STRING command,
are correct for the program compile options.

4. |If the program is compiled with a CCSID that is different than is specified in
the CICS SIT parameter LOCALCCSID, you will need specify the
programs' CCSID by adding the FROMCCSID parameter to the PUT
CONTAINER command, and adding the INTOCCSID parameter to the
GET CONTAINER command.

5. Compile the program using your local COBOL compile procedures.
Make the object library available to the CICS region if it is not already.
7. Define and install a PROGRAM definition with:
o Name: CA1YCOB1
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o Task data location: ANY
8. Define and install a TRANSACTION definition with:
o Name: COB1
o Program: CA1YCOB1
Customize the event:

1. Use the CICS Explorer to expand the calyExampleEvents project and
edit Email1CA1YCOB1.evbind.

2. Select the Specification tab, then select the OrderPlaced specification.

o Notice the Capture Point tab shows this is a SIGNAL EVENT
command.

o The Filtering tab shows the event name is OrderPlaced.

o The Information Sources tab shows how each of the business
information items are obtained from the programs' two containers.

Select the Adapter tab.

The import property loads further properties from a file on zFS. Change
the file path and name to match the mail server file created as part of
Optionally create an email server properties file on page 10.

5. Noticethemail.to, mail.subject,andmail.content properties all
have values that include tokens to embed the business information items
extracted from the containers created by the program.

Save the event binding and close the editor.
Deploy the calyExampleEvents project to zFS.
If the BUNDLE resource CA1YEXAM is currently enabled:
o Disable BUNDLE CA1YYEXAM.
o Discard BUNDLE CA1YYEXAM.
9. Install BUNDLE CA1YEXAM.

Your can now run transaction COB1 at a terminal to execute program CA1YCOB1
and issue the event. The event will be captured and the SupportPac custom
adapter will format the email and send it to the SMTP server. Your email application
will then pick up the email from the SMTP server.
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Chapter 4. Examples to send an email by linking to

program CA1Y

These examples illustrates how to send an email by using the LINK command to
start SupportPac program CA1Y.

Send an email with an attachment using a single container

This example creates a container named CA1Y with properties for the email
headers, body, an attachment, and mail server. The example then issues a LINK
command to program CA1Y. The SupportPac sends the email and returns a
container named CA1YRESPONSE with true if the email was sent, otherwise

false.

Identification Division.
Program-id. CA1YCOB2.
Environment division.
Data division.

KRR A A AR AR A A A A A A AR A A A A A A AR A A A A A A AR A KA IR A A A AR A A A A A A AR A A AR A A Ak A Ak kK

Working-storage section.
01 CONFIG.

02 CONFIG-CHANNEL-NAME PIC X(16) VALUE 'MyChannel
02 CONFIG-CONTAINER-NAME PIC X(16) VALUE 'CAlY

02 CONFIG-DATA-LENGTH PIC 9(8) COMP VALUE O.

02 CONFIG-DATA PIC X (2048) VALUE SPACES.

01 CR PIC X (1) VALUE X'25'.

KRR A A AR AR A AR A A A AR A A A A A A AR A A A A A A AR AR AR A A A A AR A A A A A A AR A A AR A A Ak A Ak kK

Linkage section.
Procedure division.
Main-program section.

* Create a container with the email headers, body, attachment,

* and import for the email server properties.

STRING
'mail.to="Joe Bloggs" <joe.bloggs@example.com>' CR
'mail.subject=Email from {REGION APPLID}' CR
'mail.content=This email was sent '
'on {datetime=EEE, d MMM yyyy HH:mm:ss Z} '
'from transaction id {TASK TRANID}, '
'user id {TASK USERID}, '
'program {TASK PROGRAM}, '
'task number {TASK NUMBER}, '
"CICS SYSID {REGION SYSID}, '
'CICS APPLID {REGION APPLID}.' CR
'attachment={file=/usr/lpp/caly/examples/"'
'picture.png:binary}' CR
'import.private={file=/usr/lpp/caly/examples/"'
'emailServer.properties:encoding=UTF-8}"' CR
X'00"'
DELIMITED BY SIZE INTO CONFIG-DATA.

INSPECT CONFIG-DATA TALLYING CONFIG-DATA-LENGTH
FOR CHARACTERS BEFORE INITIAL X'0O0'.

EXEC CICS PUT CONTAINER (CONFIG-CONTAINER-NAME)

CHANNEL (CONFIG-CHANNEL-NAME)

FROM (CONFIG-DATA) FLENGTH (CONFIG-DATA-LENGTH) CHAR
END-EXEC.

EXEC CICS LINK PROGRAM('CAlY')
CHANNEL (CONFIG-CHANNEL-NAME)
END-EXEC.

EXEC CICS RETURN END-EXEC.

Examples to send an email by linking to program CA1Y
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Use the following steps to edit, compile and install the program:

1. Copy the program source from /usr/lpp/caly/examples/CA1YCOB2
to a COBOL source data set.

2. Edit the program and change the mail . to property to your email address,
and import.private property to match the mail server file created as
part of Optionally create an email server properties file on page 10.

3. Ensure that special characters, such as @ {} () in the STRING command,
are correct for the program compile options.

4. If the program is compiled with a CCSID that is different than is specified in
the CICS SIT parameter LOCALCCSID, you will need specify the
programs CCSID by adding the FROMCCSID parameter to the PUT
CONTAINER command, and adding the INTOCCSID parameter to the
GET CONTAINER command.

5. When linking to program CA1Y it expects the CONTAINER named CA1Y
to include the initial set of properties.

6. Notice the property attachment that will result in the email having an
attachment loaded from the named file.

Compile the program using your local COBOL compile procedures.
8. Make the object library available to the CICS region if it is not already.
Define and install a PROGRAM definition.
o Name: CA1YCOB2

10. Define and install a TRANSACTION definition.
o Name: COB2
o Program: CA1YCOB?2

You can now run transaction COB2 that will prepare the containers and LINK to
program CA1Y that will prepare and send the email.

Send an email with an attachment using multiple containers

This example creates separate containers for the email recipient, subject, content
and attachment that may be more convenient for the application developer than
creating a single configuration container.

It also creates a container named CA1Y that includes tokens that will be replaced
with the contents of the named containers. The example then issues a LINK
command to program CA1Y. The SupportPac sends the email and returns a
container named CA1YRESPONSE with true if the email was sent, otherwise
false.

Identification Division.
Program-id. CA1YCOB3.
Environment division.
Data division.
P S b e I I I b I b b b I 2 b I I b b b b b I I b b i I b b I I b b b I b b I I b b I b b b b I b b b b b b b b b b b i
Working-storage section.
01 CONFIG.
02 CONFIG-CHANNEL-NAME PIC X(
02 CONFIG-CONTAINER-NAME PIC X(

16 VALUE 'CAlY
16
02 TO-CONTAINER-NAME PIC X (16
(1
(1
(1

)
) VALUE 'CAlY
) VALUE 'TO
02 SUBJECT-CONTAINER-NAME PIC X(16) VALUE 'SUBJECT
02 CONTENT-CONTAINER-NAME PIC X (16
02 ATTACH1-CONTAINER-NAME PIC X (16
01 WORKAREA.

02 WORKAREA-DATA-LENGTH PIC 9(8) COMP VALUE O.

) VALUE 'CONTENT
) VALUE 'ATTACHI1
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02 WORKAREA-DATA PIC X (1024) VALUE SPACES.
01 CR PIC X(1)  VALUE X'25'.
khkkhkkhkkhkhkhkkhkhkhkhkhhkhkhkhhkkhkhkhhhhkhkhkhhhkhhkhhhkhhkhrhhkhkhhhhkhkhkhrhkhkkhkhkhrhrhkkhhkhrhrhkkhkhhrhkhkhkx
Linkage section.
Procedure division.
Main-program section.

STRING
'import.private={file=/usr/lpp/caly/examples/"'
'emailServer.properties:encoding=UTF-8}"' CR
'mail.to={' TO-CONTAINER-NAME '}' CR
'mail.subject={"' SUBJECT-CONTAINER-NAME '}' CR
'mail.content={' CONTENT-CONTAINER-NAME '}' CR
'attachment={mime=application/octet-stream}"'
'{' ATTACH1-CONTAINER-NAME '}' CR
X'00"'

DELIMITED BY SIZE INTO WORKAREA-DATA.

MOVE 0 TO WORKAREA-DATA-LENGTH.
INSPECT WORKAREA-DATA TALLYING WORKAREA-DATA-LENGTH
FOR CHARACTERS BEFORE INITIAL X'00'.

EXEC CICS PUT CONTAINER (CONFIG-CONTAINER-NAME)

CHANNEL (CONFIG-CHANNEL-NAME)

FROM (WORKAREA-DATA) FLENGTH (WORKAREA-DATA-LENGTH) CHAR
END-EXEC.

STRING '"Joe Bloggs" <joe.bloggs@example.com>' X'00'
DELIMITED BY SIZE INTO WORKAREA-DATA.

MOVE 0 TO WORKAREA-DATA-LENGTH.
INSPECT WORKAREA-DATA TALLYING WORKAREA-DATA-LENGTH
FOR CHARACTERS BEFORE INITIAL X'00'.

EXEC CICS PUT CONTAINER (TO-CONTAINER-NAME)

CHANNEL (CONFIG-CHANNEL-NAME)

FROM (WORKAREA-DATA) FLENGTH (WORKAREA-DATA-LENGTH) CHAR
END-EXEC.

STRING 'Email from {REGION APPLID}' X'0O'
DELIMITED BY SIZE INTO WORKAREA-DATA.

MOVE 0 TO WORKAREA-DATA-LENGTH.
INSPECT WORKAREA-DATA TALLYING WORKAREA-DATA-LENGTH
FOR CHARACTERS BEFORE INITIAL X'00'.

EXEC CICS PUT CONTAINER (SUBJECT-CONTAINER-NAME)

CHANNEL (CONFIG-CHANNEL-NAME)

FROM (WORKAREA-DATA) FLENGTH (WORKAREA-DATA-LENGTH) CHAR
END-EXEC.

STRING 'This email was sent
'on {datetime=EEE, d MMM yyyy HH:mm:ss Z} '
'from transaction id {TASK TRANID}, '

'user id {TASK_USERID}, '

'program {TASK PROGRAM}, '

'task number {TASK NUMBER}, '

"CICS SYSID {REGION SYSID}, '

'CICS APPLID {REGION_APPLID}.'

X'00"

DELIMITED BY SIZE INTO WORKAREA-DATA.

Examples to send an email by linking to program CA1Y
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MOVE 0 TO WORKAREA-DATA-LENGTH.
INSPECT WORKAREA-DATA TALLYING WORKAREA-DATA-LENGTH
FOR CHARACTERS BEFORE INITIAL X'00'.

EXEC CICS PUT CONTAINER (CONTENT-CONTAINER-NAME)
CHANNEL (CONFIG-CHANNEL-NAME)
FROM (WORKAREA-DATA) FLENGTH (WORKAREA-DATA-LENGTH) CHAR

END-EXEC.

STRING X'0102030405060708090A0BOCODOEOQE"

X'00"'

DELIMITED BY SIZE INTO WORKAREA-DATA.

MOVE 0 TO WORKAREA-DATA-LENGTH.
INSPECT WORKAREA-DATA TALLYING WORKAREA-DATA-LENGTH
FOR CHARACTERS BEFORE INITIAL X'00'.

EXEC CICS PUT CONTAINER (ATTACH1-CONTAINER-NAME)
CHANNEL (CONFIG-CHANNEL-NAME)
FROM (WORKAREA-DATA) FLENGTH (WORKAREA-DATA-LENGTH) BIT

END-EXEC.

EXEC CICS LINK PROGRAM('CAlY')
CHANNEL (CONFIG-CHANNEL-NAME)

END-EXEC.

EXEC CICS RETURN END-EXEC.

1.

Copy the program source from /usr/lpp/caly/examples/CA1YCOB3
to a data set.

Edit the program and change the mail recipient to your email address, and
import.private property to match the mail server file created earlier as part
of Optionally create an email server properties file on page 10.

Ensure that special characters, such as @ {} () in the STRING command,
are correct for the program compile options.

If the program is compiled with a CCSID that is different than is specified in
the CICS SIT parameter LOCALCCSID, you will need specify the
programs CCSID by adding the FROMCCSID parameter to the PUT
CONTAINER command, and adding the INTOCCSID parameter to the
GET CONTAINER command.

Notice the property attachment that will result in the email having an
attachment loaded from the container named ATTACHI.

Compile the program using your local COBOL compile procedures.
Make the object library available to the CICS region if it is not already.
Define and install a PROGRAM definition.

°©  Name: CA1YCOB3
Define and install a TRANSACTION definition.

o Name: COB3

o Program: CA1YCOB3

You can now run transaction COB3 that will prepare a set of containers and LINK
to program CA1Y that will prepare and send the email.
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Chapter 5. Example to write to a TD queue using the
CA1Y event adapter

This example illustrates how to emit a CICS event to the temporary data (TD)
queue CSSL that is typically directed to the CICS MSGUSR log. This could be
useful for automation tools to make use of the event or to simply audit events.

First follow Examples to send an email using the CA1Y event adapter on page 15.

Within the calyExampleEvents project, edit the event binding sample
TDQCA1YCOB1.evbind then select the Adapter tab.

i TDQCA1YCOB1.evbind 22 = 8

=

Use a predefined EPADAPTER or EPADAPTERSET resource, or use an adapter that you specify here.
Use a predefined EPADAPTER resource
Use a predefined EPADAPTERSET resource

@® Use an adapter defined here

Choose the adapter and settings to emit events.
Adapter cystom (User Written) =

Emits events in any format that you require. A custom EP adapter is a CICS program that you write to provide a
combination of formatting and routing of an event that is not supported by the CICS-supplied EP adapters. The custom
EP adapter must not carry out any other processing, such as consumption of the event.

Transaction ID |CA1Y

Data passed to the Custom Adapter

queue=CSSL
queue.type=td

queue.content=An order for {ItemQuantity} * {ItemDescription} was raised and will be sent to the address {Address}.
queue.content.length.chunk=80|

Event Binding | Specification | Adapter

Notice in the Data passed to the Custom Adapter section the following properties
will set the name of the queue to CSSL, the type of queue to TD, the content to

write to the queue, and to write multiple records to the queue if the content is over
80 characters.

queue=CSSL
queue.type=td

queue.content=An order for {ItemQuantity} * {ItemDescription}
was raised and will be sent to the address {Address}.

queue.content.length.chunk=80

Run transaction at COB1 at a terminal. The following two records will be written to
CSSL that will likely be redirected to MSGUSR:

An order for 1 * Rope was raised and will be sent to the
address Rockclimbing Av

enue.
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Chapter 6. Example to send an event to an HTTP server

CICS provides an HTTP adapter that is able to format an event as XML and send it
to an HTTP server. If you have a robust network between CICS and the HTTP
server, and the adapter provides suitable formatting for your event, it is
recommended you use this support as its performance will be better than this
SupportPac.

26

The SupportPac however provides a more flexible approach to formatting the event
and is able to retry the emission if there are network failures.

The example below shows how to format the event as JSON (JavaScript Object
Notation), and if there are network failures retry up to 3 times.

1.

6.

Create a URIMAP named MYSERV. Specify the usage as client, and the
HTTP server address, path, port, scheme, and security details.

Copy the calyExampleEvents CICS bundle project used in Examples to
send an email using the CA1Y event adapter on page 15 and give it the
name calyExampleEventsHTTP.

Rename EmailExmpcatEnableStatus.evbind to
HTTPExmpcatEnableStatus.evbind and delete the other .evbind files.

Edit HTTPExmpcatEnableStatus.evbind and in event binding editor
Adapter tab, enter the following into the Data passed to the custom
adapter section:

http.urimap=MYSERV
http.content={noinnertokens} {json}
http.retry=3

http.retrydelay=1000

Save the event binding.
Export the CICS bundle to zFS and create and install a BUNDLE definition.

Now when the status of file EXMPCAT is changed to disabled, the event will be
captured, and the SupportPac started. The SupportPac will format the event into a
JSON format and sent it to the HTTP server configured in the URIMAP.
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Chapter 7. Example to convert XML to a PDF document

by linking to program CA1Y

This example illustrates how to convert an XML document to a PDF document

using an XSLT stylesheet.

The container named CA1Y is created with three properties:

1. org.apache.xalan.processor.TransformerFactoryImpl to
specify the Xalan-Java XSLT processor should be used for XSLT

transformation.

MyXSLT that loads the XSLT document from zFS.

MyPDF that specifies the XML to convert into a PDF and return it back to
the program in the container named PDF. The PDF documented is created

by converting the XML from type text/xml to application/pdf using the

XSLT.

The SupportPac program CA1Y is then called to create the PDF document. The

PDF document is then retrieved from the PDF container.

Identification Division.
Program-id. CA1YCOB4.
Environment division.
Data division.

KA R AR A AR AR A A A A AR AR A A A A AR AR A IR A A I A AR AR A A A A A A A A A A A A Ak A A Ak kA kh %

Working-storage section.

01 CONFIG.
02 CONFIG-CHANNEL-NAME PIC X (16) VALUE 'MyChannel '
02 CONFIG-CONT-NAME PIC X (16) VALUE 'CAlY .
02 CONFIG-DATA-LENGTH PIC 9(8) COMP VALUE O.
02 CONFIG-DATA PIC X (2048) VALUE SPACES.

01 PDF-DOC.
02 PDF-CONT-NAME PIC X(16) VALUE 'PDF .
02 PDF-DATA-LENGTH PIC 9(8) COMP VALUE O.
02 PDF-DATA PIC X(10240) VALUE SPACES.

01 RESPONSE.
02 RESPONSE-CONT-NAME PIC X(16) VALUE 'CAlYRESPONSE .
02 RESPONSE-DATA-LENGTH PIC 9(8) COMP VALUE O.
02 RESPONSE-DATA PIC X(16) VALUE SPACES.

01 CR PIC X (1) VALUE X'25'.

khkkhkkhkhkhkhkkhkhkhkhkhhkhkhkhrhkkhkhkhkhhhkhhkhrhhhkhhhhkhhkhhkhkhkhhhhdhhkhrhkhkhkhohkhkkhkkhhkrhkkhkkhkhrhhkhkx%k
Linkage section.

Procedure division.

Main-program section.

STRING
'javax.xml. transform.TransformerFactory="'
'org.apache.xalan.processor.TransformerFactoryImpl' CR
'"MyXSLT={file=/usr/lpp/caly/examples/helloWorld.xslt'
' :encoding=UTF-8}' CR

'MyPDF={responsecontainer=' PDF-CONT-NAME '}'

' {mime=text/xml:to=application/pdf:xslt=MyXSLT}'
'<?xml version="1.0" encoding="UTF-8" ?>'
'<name>Joe Bloggs</name>' CR

X'00"'
DELIMITED BY SIZE INTO CONFIG-DATA.

INSPECT CONFIG-DATA TALLYING CONFIG-DATA-LENGTH
FOR CHARACTERS BEFORE INITIAL X'00'.

EXEC CICS PUT CONTAINER (CONFIG-CONT-NAME)
CHANNEL (CONFIG-CHANNEL-NAME)

Example to convert XML to a PDF document by linking to program CA1Y
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FROM (CONFIG-DATA) FLENGTH (CONFIG-DATA-LENGTH) CHAR
END-EXEC.

EXEC CICS LINK PROGRAM('CAlY')
CHANNEL (CONFIG-CHANNEL-NAME)
END-EXEC.

COMPUTE RESPONSE-DATA-LENGTH = LENGTH OF RESPONSE-DATA.
EXEC CICS GET CONTAINER (RESPONSE-CONT-NAME)

CHANNEL (CONFIG-CHANNEL-NAME)

INTO (RESPONSE-DATA) FLENGTH (RESPONSE-DATA-LENGTH)
END-EXEC.

COMPUTE PDF-DATA-LENGTH = LENGTH OF PDF-DATA.
EXEC CICS GET CONTAINER (PDF-CONT-NAME)
CHANNEL (CONFIG-CHANNEL-NAME)
INTO (PDF-DATA) FLENGTH (PDF-DATA-LENGTH)
END-EXEC.

EXEC CICS RETURN END-EXEC.
1. Copy the program source from /usr/lpp/caly/examples/CA1YCOB4
to a COBOL source data set.

2. Edit the program source if you need to modify the property MyXSLT with a
different location for the XSLT file.

Compile the program using your local COBOL compile procedures.
Make the object library available to the CICS region if it is not already.
Define and install a PROGRAM definition.
o Name: CA1YCOB4
6. Define and install a TRANSACTION definition.
o Name: COB4
o Program: CA1YCOB4

You can now run transaction COB4 to create the PDF document. Use CEDF to
step through the CICS API calls. You could modify the program to send the PDF as
an email attachment, send it to a web services client, or save it to DB2.
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Chapter 8. Properties

The SupportPac acts upon information passed to it as properties.
Place the properties in one of the following locations:

« If the SupportPac will be started as a CICS event custom adapter, place
the properties in the Data passed to the Custom Adapter field in the
adapter tab in the CICS Explorer event adapter editor or event binding
editor.

» If the SupportPac will be started as a result of a CICS policy being
triggered, place the properties in the Data passed to the Custom Adapter
field in the adapter tab in the CICS Explorer event adapter editor.

» If the SupportPac will be started by a LINK CHANNEL() or START
CHANNEL() command, place the properties in a character container
named CA1Y. Ensure the container is created with the CCSID of your
program by specifying FROMCCSID or FROMCODEPAGE parameters on
the PUT CONTAINER command.

» If the SupportPac will be started by a LINK COMMAREA() or START
FROM() command, place the properties in the commarea. The content is
required to be in the CICS region local CCSID in which CA1Y executes.

Properties are specified using the format name=value and are case sensitive. Each
property should end with a new line or line feed character.

To split a value over several lines, use the \ continuation character at the end of the
line. To insert a new line character in a property value use \n. Blank lines, and lines
where the first non-blank character is # or ! are used for comments and are
ignored. Further formatting rules and an alternative XML notation are described in
the Java Properties class load method at java.util.Properties load.

If a property is specified more than once, the last instance will take effect.
It is advisable to avoid property names that clash with the names of tokens.

Property values can contain tokens that are replaced as described in Tokens on
page 37. Properties are processed in alphanumeric name order to resolve the
tokens.

Additional properties can be imported from an external source such as a file that
can be maintained independent to the event adapter configuration or program.

A combination of properties could be used to, for example, send an email and write
to a temporary data queue. However, when using CICS events you may prefer to
define these in separate event adapter configurations to maintain their
independence in failure scenarios. Also from CICS TS V5.1 you can emit one
captured event to multiple adapters using adapter sets.

General properties

Use these properties to import properties from other sources, to link to a program
when there is a failure to process the request, and to define the regular expression
to identify tokens.

Property

Usage and examples

import=value

Import additional properties.

import={file:/path/standard.pro Properties are imported from the
perties} named file using the JVM default file
encoding.

import={file:/usr/lpp/caly/exam Properties are imported from the

ples/emailServer.properties:enc npamed file using the UTF-8 encoding.
oding=UTF-8}

Properties
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Property

Usage and examples

import={doctemplate=MyTemplate} Properties are imported from a CICS
DOCTEMPLATE resource that is
cached in memory upon first use.

import.private=value

Import additional properties and prevent the values of these properties from
appearing in log files, or being copied using tokens. This is useful if the tokens
include passwords such as for mail servers.

import.private={file:/usr/lpp/caly/examples/emailServer.properti
es:encoding=UTF-8}

onfailure=program

Specify the CICS program the SupportPac will link to if there is a failure to
process the request. Your program can access the containers passed to the
SupportPac plus those created by specifying the responsecontainer token
in a property.

http.content=Hello from CICS. { Aneventis senttoan HTTP server

responsecontainer=HTTPCONTENT}  defined in a URIMAP. If there is a

htt . CHTTPSERV failure, the SupportPac links to
p.urimap= program ERRLOG to log the

onfailure=ERRLOG HTTPCONTENT container to DB2.

token.regex=pattern

Specify a regular expression pattern to identify the start and end of a token.
Valid patterns are detailed in the Java Pattern class. The default pattern starts
a token with an opening curly bracket { and ends with a closing curly bracket }

For example if you need to replace tokens in JSON data, you will need to
change this pattern as JSON uses curly brackets to denote arrays.

token.regex=\\$\\{ (.+?)\\} A token is defined to start with ${ and
end with }

SMTP mail properties

Use these properties to send an email to a SMTP mail server. Most of the
properties are used by the JavaMail API to construct email headers and content,
and to interact with a mail server. These and other advanced properties to secure
the connection are detailed in Package com.sun.mail.smtp.

You are required to set at least one of the mail.to, mail.cc, or mail.bcc properties.

To add an attachment to the email, define a property with the attachment contents
and include a mime token to set the MIME type. The attachment name can be set
using the name token as shown in Examples using tokens for email attachments
on page 42.

If the email could not be delivered to one of the recipients, for example due to an
incorrect email address, the SMTP server will send a failure report to the senders'
email address specified in the mail.from property. Delivery failures may take some
time to arrive due to interactions with relay servers.

Property name

Usage and examples

mail.bce Email address list in REC 822 syntax of who should receive the email as a
blind carbon copy.
email.bcc=userlexample.com

mail.cc Email address list in REC 822 syntax of who should receive the email as a

carbon copy.

email.cc=user@example.com

mail.content

Content of the mail, typically plain text or HTML.

mail.content=Hello from CICS.

30
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Property name

Usage and examples

mail.content=<html><hl>Hello from CICS.</hl></html>

mail.from

Email address in REC 822 syntax of who sent the email.

email.from=cics@example.com

mail.sentdate

CICS ABSTIME, returned via a EXEC CICS ASKTIME ABSTIME(), to use for
the email sent date and time.

If not specified and CA1Y is started by a CICS event, the date and time of the
CICS event is used, otherwise the Java date and time used.

mail.sentdate=003609661860917

mail.host

SMTP server host name.

mail.host=smtp.example.com

mail.password

SMTP user password.

mail.password=mypassword

mail.reply.to

Email address in REC 822 syntax of who replies should be sent.

email.reply.to=helpdesk@example.com

mail.smtp.auth

If true, the userid and password will be used to authenticate with the mail
server.

mail.smtp.auth=true

mail.smtp.port

SMTP server port number. The default is 25.
mail.smtp.port=25

mail.subject

One line of text describing the email subject.

mail.subject=Example email

mail.to

Email address list in REC 822 syntax of who should receive the email.
mail.to=userlexample.com
mail.to="Joe Bloggs" <j.bloggs@example.com>

mail.to="Joe Bloggs" <j.bloggs@example.com>, “A N Other” <a.n.o
ther@example.com>

mail.transport.protocol

Mail server protocol.

mail.transport.protocol=smtp

mail.user

SMTP user name.

mail.user=joe.bloggslexample.com

Saxon and Apache FOP properties

Use these properties to specify the Java class to use for XSLT transformations,
and to specify additional configuration for the Apache FOP.

Property name

Meaning and examples

fop.config.file=value

Apache FOP configuration file as defined at
http://xmlgraphics.apache.org/fop/1.1/configuration.html

fop.config.file=/path/config.xml

javax.xml.transform.Tr
ansformerFactory=class

Properties

Specify the Java class name to use to transform XSLT.

javax.xml.transform.TransformerFactor Use the Apache FOP
y=org.apache.xalan.processor.Transfor transformer for XSLT
merFactoryImpl procesﬂng.
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Property name Meaning and examples

javax.xml.transform.TransformerFactor Use the Saxon transformer for
y=net.sf.saxon.TransformerFactoryImpl XSLT processing.
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Queue properties

Use these properties to write content to a CICS temporary storage (TS) or
temporary data (TD) queue.

Property

Usage and examples

queue=gName

Required. The queue name. Follow the queue naming rules defined by CICS.
For TS queues see QNAME(name). For TD queues see QUEUE(name).

queue=MyQueue

queue.content=value

Required. Text content to write to the queue.

queue.content=Hello from CICS.

queue.content={file=//DD:MYDA The text is retrieved from the named
TAS (MEMBER) } dataset member to write to the queue.

queue.content={ file=/path/pic Binary content is retrieved from the named
ture.png:binary} ZFS file to write to the queue.

queue.content.encodin
g=value

Content is written to the queue using the specified encoding. If not specified the
CICS region local CCSID will be used.

queue.content.encoding=Cpl047

queue.content.length.
chunk=maxlength

The maximum length of content to write in a single queue record. If the content
is beyond this length, multiple queue records will be written. In this situation it is
possible other CICS tasks may write records to the same queue and become
interspersed with records written by this task. If this property is not specified, the
content will be written as a single record and truncation may occur.

queue.content.length.chunk=32763

queue.content.length.
max=maxLength

The maximum length of content to write to the queue. Content over this length is
truncated.

queue.content.length.max=32763

queue.sysid=sysID

The remote system identifier (SYSID) where the queue resides. If this property
is not specified, the queue is assumed to be local to the CICS region that is
executing the SupportPac.

queue.sysid=SYS1

queue.ts.storage=type

Specify the queue is to be created in main or auxiliary storage if it does not
already exist. If not specified, main is assumed.

queue.ts.storage=main

queue.ts.storage=auxiliary

queue.type=value

Specify the queue type. If not specified, temporary storage is assumed.
queue.type=ts Write to a temporary storage queue

queue. type=td Write to a temporary data queue

Properties
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Batch job submission property

Use this property to submit content as a Job Control Language (JCL) batch job to
the MVS internal reader facility using the JZOS MvsJobSubmitter class.

Use the escape sequence \n to insert a new line, and the backslash character \ to
continue onto the next line. The maximum length of each line in the batch job is 80
characters once all tokens have been resolve.

The SupportPac does not wait for the batch job to start executing. Use MVS Job
Entry Subsystem (JES) facilities to check progress, successful execution, and
output of the batch job.

If the SupportPac is started by a LINK command, the submitted job ID is returned
in the container named mvsjob.jobid.

Property

Usage and examples

mvsjob.content=value

Required. The contents of the property are submitted to MVS as a batch job.

In this example a modify command is issued against the CICS region to set a file
enabled. The EPCX APPLID and File name tokens are replaced with the
captured items from file system event.

mvsjob.content=//MODIFY JOB CLASS=M,MSGCLASS=H \n\
//IEFBR EXEC PGM=IEFBR14 \n\
// F {EPCX_APPLID}, 'CEMT SET FILE({File name}) ENABLE'

This example is similar to the above except the content of the batch job is
retrieved from a dataset member, with the property token command replaced with
the contents of the property of the same name.

command=CEMT SET FILE ({File name}) ENABLE
mvsjob.content={file=//"MYJOBS.JCL (SKELETON) '}

The contents of MVS file MYJOBS.JCL(SKELETON):

//MODIFY JOB CLASS=M,MSGCLASS=H
//IEFBR EXEC PGM=IEFBR14
// F {EPCX APPLID}, ' {command}"'
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HTTP properties

Use these properties to send a request to an HTTP server using the CICS web
facilities.

The SupportPac uses the CICS WEB OPEN and WEB SEND commands to
connect to the HTTP server and send the request. The timeout for these
commands is specified in the DTIMOUT attribute of the TRANSACTION definition
under which the SupportPac is started. If started as a custom event adapter or
START CHANNEL command, the default transaction ID is CA1Y. If started by a
LINK command, the transaction ID is that of the caller.

It is recommended to define a CICS URIMAP resource to specify the HTTP server
details, then specify the resource name with the http.urimap property. CICS
provides useful monitoring data and can reuse the connection when a URIMAP
resource is used.

If the HTTP server returns a 401 response to indicate credentials are required, and
you specify http.urimap, or you specify http.uri without a user and
password, then CICS will call the XWBSNDOQO and XWBAUTH exits as described in

topic Providing credentials for basic authentication to obtain the credentials and
resend the request.

Property

Usage and examples

http.certificate=label Set the label of the X.509 certificate to use if connecting to the HTTP

server using SSL. For more details see the WEB OPEN command.

http.certificate=MyCertificate

http.characterset=codepage Set the character set of the HTTP content. The default is iso-8859-1.

For more details see the WEB SEND command.
http.characterset=UTF-8

http.content=value

Required. Specify the content to send to the HTTP server. It is
important that the MIME is set appropriately, otherwise the HTTP server
will fail to understand the content. The default MIME text/plain will be
used if not specified using the mime token.

http.content=Hello Send the text Hello to an HTTP server.

http.content={json} Send a JSON document. The json token
will set the MIME type to application/json.

http.content= Send a Common Base Event Rest
{commonbaseeventrest}  document. The commonbaseeventrest
token will set the MIME type to text/xml.

http.method=method

Set the HTTP request method as described in REC2616. The default is
PUT. For more details see the WEB SEND command.

http.method=POST Use POST to create a new resource.
http.method=PUT Use PUT to add content to an existing
resource.

http.retry=number

Set the number of times the request should be retried. The default is O,

meaning do not retry. The request will only be retried when:

1. Asocket error is received.

2. Aresponse is not received due to a timeout.

3. An HTTP error response is received and the header Retry-After is
present. In this case the value in seconds specified in this header is
used to delay the retry. However if the delay retry is greater than 60
seconds the request is failed immediately.

http.retry=3

Properties
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Property

Usage and examples

http.retrydelay=milliseconds Setthe time in milliseconds to wait after each HTTP failure before

retrying. The default is 500ms.
http.retrydelay=10000 Delay for 10 seconds before retrying.

http.uri=uri

Set the scheme, hosthame, and optionally user name, password, port,
path and query string to be used to connect to the HTTP server. The
URI format is described by RFC3986.

This property will be ignored if http.urimap is also specified.

http.uri=http://myserver.example.com/resource

http.uri=http://username:password@server.example.com:8080/
path?name=fred

http.urimap=urimap

Set the CICS URIMAP resource name to use to connect to the HTTP
server. The URIMAP resource should have usage set to CLIENT, and
include the scheme, hostname, path and optionally port and query
string.

http.urimap=MyServer

MVS console message properties

Use these properties to write an MVS console message using the write to operator
(WTO) macro via the JZOS MvsConsole class.

Property

Usage and examples

mvswto.content=value

Required. The contents of the property are submitted to the MVS console.

mvsjob.content=WTO message content

mvswto.descriptor=code

An integer for the MVS descriptor code. A description and rules governing
these codes are documented in the Descriptor codes topic in z/OS MVS
System Messages.

mvswto.descriptor=16
mvswto.descriptor=DESC_IM As above, but using the constants that start
PORTANT_ INFORMATION MESSA DESC defined in class

GES com.ibm.jzos.WtoConstants rather than an
integer.

mvswto.route=code

Specify an integer for the MVS routing code. See the Routing codes topic in
z/OS MVS System Messages for a description and rules governing these
codes.

mvswto.route=32

mvswto.route=ROUTCDE_PROG As above, but using a constant defined in
RAMMER INFORMATION class WtoConstants rather than an integer.
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Chapter 9. Tokens

Tokens are used to dynamically create or retrieve content from a variety of sources.

Each property passed to the SupportPac has a value, and the value can contain
tokens that are replaced with content as described in the tables below.

The SupportPac identifies a token by searching the property value for a regular
expression. By default the regular expression requires a token is prefixed with a

{ character and suffixed with a } character. You can change the regular expression
using the token.regex property.

Tokens and their parameters are case sensitive, and the parameters are required
to be in the order specified. Some parameters are optional.

A token cannot be placed within another token.

If the token is invalid, for example it specifies a file name that does not exist, it will
be removed and may result in messages being written to the Java stderr.

Token Usage and examples

pbroperty Token is replaced with the contents of the property. Properties considered
private, i.e. loaded using the import.private property, will not be
replaced.
mail.content=This email is being sent to {mail.to}

container If the container is a character (CHAR) type, the token is replaced with the

contents of the container.

If the container is a binary (BIT) type, the contents are attached to the
property, or appended if one already exists. This will also set the
attachment name to the container name if it is not already set using the
token name.

{MyContainer} Replace the token with the contents
of MyContainer.

jvmmproperty

The token is replaced with the value of the specified JVM system property.
You can set a JVM system property in the CICS JVM profile using the
convention -Dproperty=value.

In the JVM profile: The JVM property myProperty is set

-DmyProperty=Greetings in the JVM profile, and the
{myProperty} token is replaced with

Example token: “Greetings”.

{myProperty}

{com.ibm.cics.jvmserver.confi The token is replaced with the JVM

groot} server configuration route directory.
This property was new at CICS TS
V5.2

commonbaseeventrest

Token is replaced with an XML document referred to as the common base
event REST format. In addition to header elements, all event business
information items are automatically included. Additional properties can be
added using the emit token. The property MIME is set to text/xml.

{commonbaseeventrest}

commonbaseevent

Token is replaced with an XML representation referred to as the common
base event format. In addition to header elements, all event business
information items are automatically included. Additional properties can be
added using the emit token. The property MIME is set to text/xml.

{commonbaseevent}

Tokens
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Token Usage and examples

datetime=format Token is replaced with the date and time using the Java SimpleDateFormat
format as detailed under heading Date and Time Patterns. If CA1Y is
started as a custom event adapter, the date and time is from when the
event was captured. Otherwise the current date and time as known by the
JVM server is used.

{datetime=yyyy.MM.dd 'at' HH:mm:ss z}

{datetime=} Token is replaced with the default
Java date and time format. For Java
7 this is:
dow mon dd hh:mm:ss zzz yyy
Yy

doctemplate=name Token is replaced with the contents of the CICS DOCTEMPLATE resource
named by name. The DOCTEMPLATE type should be EBCDIC. Note for
improved performance CICS will cache DOCTEMPLATE resources once
first used. The cached copy can be discarded by disabling then re-enabling
the resource.

{doctemplate=MyTemplate} Replace the token with the contents
of MyTemplate.

doctemplate=name:binary As above except the contents are treated as binary and the
DOCTEMPLATE type should be binary.

{doctemplate=MyTemplate:binary}

emit Include this property when processing tokens commonbaseeventrest,
commonbaseevent,andjson.

MyProperty={emit}Hello Emit this property when creating one
of the above document types.

file=filename Token is replaced with the contents of the fully qualified file on zFS, where
the contents are loaded using the default Java character set encoding.
Note the contents are not cached. If caching is required use a
DOCTEMPLATE resource.

{file=/path/name.ext}

file=filename:encoding=co As above except the contents are read using the specified Java character
depage set encoding.

{file=/path/name.ext:encoding=US-ASCII}
{file=/path/name.ext:encoding=Cpl047}

{file=/path/name.ext:encoding=UTF-8}

file=filename:binary As above except the contents are read as binary.

{file=/path/name.ext:binary}

file=//'datasetName' Token is replaced with the contents of the fully qualified dataset. If the
dataset is a PDS, a member must be specified. See the JZOS Zfile
constructor for more examples. Note the contents are not cached. If
caching is required use a CICS DOCTEMPLATE resource.
{file=//'HLQ.MYSEQ"'}

{file=//"HLQ.MYPDS (SAMPMEM) '}

file=// 'datasetName':enco As above except the contents are read using the specified Java character
ding=codepage set encoding.

{file=//"HLQ.MYSEQ' :encoding=Cpl047}

file=//'datasetName':bina As above except the contents are read as binary.

r
Y {file=//"HLQ.MYSEQ':binary}
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file=//DD:ddName

Token is replaced with the contents of the dataset specified by the DD card
in the CICS JCL. If the dataset is a PDS a member can be specified. Note
the contents are not cached. If caching is required use a DOCTEMPLATE
resource.

{file=//DD:MYCARD (SAMPMEM) }

file=//DD:ddName:encoding
=codepage

As above except the contents are read using the specified Java character
set encoding.
{file=//DD:MYCARD (SAMPMEM) :encoding=Cpl047}

file=//DD:ddName:binary

As above except the contents are read as binary.
{file=//DD:MYCARD (SAMPMEM) :binary}

ftp=fileName:server=hostN
ame:username=userName:use
rpassword=password:transf
er=ascii
binary:mode=localactive
localpassive:epsv=false
true:protocol=protocol:tr
ustmgr=trustManager:datat
imeout=seconds:proxyserve
r=hostName:proxyusername=
proxyUserName: proxypasswo
rd=password

Token is replaced with the contents of the specified file retrieved from the
FTP server. The Apache Creative Commons commons-net FTPClient
framework is used to interact with the FTP server and documents these
parameters.

fileName and hostName are required and all other parameters are
optional.

fileName can include a relative or absolute path as understood by the
FTP server.

hostName can include : followed by a port number to override the default
of 21.

The default for:

* userName iS anonymous.

* transfer is ascii.

* mode is localactive.

» epsv (extended passive mode) is false.

{ftp=/path/filel.txt:server=my.host.com}

{ftp=/path/filel.txt:server=my.host.com:username=johndoe:pass
word=secret}

hex=property

Token is replaced with a hexadecimal string representation of the contents
of the specified property.

{hex=MyAttachment}

htmltable:properties=patt
ernl:containers=pattern2

Token is replaced by an HTML document containing one or two tables. The
first table has a row detailing each property whos name matches the Java
regular expression pattern1. The second table has a row detailing each
container in the default channel whos name matches the Java regular
expression pattern2. Java regular expressions are details in the Java
Pattern class.

Note: Properties loaded from import.private will have their values
excluded.

{htmltable} Include all properties and containers.

{htmltable:properties=.*} Include only properties.

{htmltable:properties=(?!
mail.*).*

Include only properties whos name
does not start with “mail”.

{htmltable:containers=MyConta
inerl|MyContainer2}

Include only containers named
MyContainer1 and MyContainer2.

Tokens
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json

Token is replaced with a JSON representation of the CICS event and the
MIME for the property is set to application/json. All event business
information items are automatically included. Additional properties can be
added using the emit token.

Note: JSON makes use of the { and } characters start and end tags for the
document and arrays. Use the token noinnertokens to prevent the
SupportPac misinterpreting these as tokens.

{noinnertokens} {json}

link=program

Link to the specified CICS program with the current channel.
{1ink=MYPROG}

mime=mediatype

Set the MIME media type of the property as defined by IANA media types.
When sending an email, all properties with a MIME are attached to the
email. Using token file=filename:binary automatically sets the
MIME based on the file name extension.

{mime=text/plain}
{mime=text/html}
{mime=text/xml}
{mime=image/jpeqg}

{mime=application/octet-stream}

mime=mime:to=mime

Set the MIME type of the property, and the MIME type the property should
be converted to.

{mime=text/xsl:to=application/pdf}

mime=mime:to=mime:xslt=pr
operty

Set the property MIME type, the MIME type the property should be
converted to, and the XSL Transformations (XSLT) to be used for the
conversion.

{mime=text/xml:to=application/pdf:xslt=MyStyleSheet}

name=name

Set the name of the attachment. If the token £ile is used in the property,
the default name is the file name and extension.

{name=My photo.jpg}

name=property

Set the name of the attachment to the contents of the named property.

MyFileName=Invoice - The property name is set to the
{datetime=yyyy-MM-dd}.pdf contents of the MyFileName property
that could evaluate to:

MyAttachment={name=MyFileName Invoice - 2013-07-09.pdf

oo

noinnertokens

Tokens for this property will be processed, however content inserted as a
result of resolving tokens will not be searched for tokens. Use this to avoid
searching within the content from files, doctemplates, or JSON documents
for tokens.

MyHTML={noinnertokens} Content is loaded from the document
{doctemplate=MyTemplate} template, but that content is not itself
searched for tokens.

nomoretokens

Token processing is stopped for the remainder of the property. Use this
when you know the property does not require token replacement.

MyHTML={normoretokens}<HTML>< The HTML is not searched for tokens.
hl>...

putcontainer=container
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Copies the content from the current resolved property into a CICS
container. If the property contains binary data the container will be type
BIT, otherwise type CHAR.
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{putcontainer=MyContainer}

responsecontainer=contain
er

Copy the contents of the property to the named CICS container once all
properties have been processed. The container will be type BIT for binary
content, otherwise will be type CHAR.

{responsecontainer=MyPDF}

systemsymbol=pattern

Token is replaced with the resolved MVS system symbol pattern specified.
The pattern takes the form &SYMBOL. or &SYMBOL(n:m). for a substring
as described by substituteSystemSymbols. Topic What are System
Symbols? in the z/OS MVS JCL Reference describes how to set and
display system symbols.

{systemsymbol=&SYSNAME. }
{systemsymbol=&SYSPLEX. }

{systemsymbol=&SYSCLONE. }

texttable:properties=patt
ernl:containers=pattern2

Token is replaced by a hexadecimal dump of the properties and containers
whos name match the Java regular expression pattern. Java regular
expressions are details in the Java Pattern class.

Note: Properties loaded from import.private will have their values
excluded.

{texttable} Include all properties and containers.
{texttable:properties=.*} Include only properties.
{texttable:properties=(?! Include only properties whos name
mail.x).x does not start with “mail”.

{texttable:containers=MyConta |nclude only containers named
inerl|MyContainer2} MyContainer1 and MyContainer2.

transform=property:xmltra
nsform=resource

Token is replaced with the results from passing the specified property and
XMLTRANSFORM resource to the CICS command TRANSFORM
DATATOXML. For information on creating the required XMLTRANSFORM

resource see Mapping and transforming application data and XML.

{transform=CustomerData:xmltransform=CustomerXML}

zip=zipName

Compress the contents of the property into a zip named by zipName.
{zip=MyZip.zip}
{zip=} If zipName is not specified, the

property name and extension .zip is
used.

zip=zipName:include=prope
rtyList

As above except compress all of the properties named in propertyList
into a single zip. Use a comma and no spaces to separate properties in the
list.

{zip=MyZip.zip:include=propertyl}

{zip=MyZip.zip:include=propertyl,property2}
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Additional tokens available with event processing

The following tokens are only available when the SupportPac is started as an event

adapter.
Token Usage and examples
event information The named event business information item, as defined using the CICS Explorer

event binding editor on the Specifications tab.

{in_stock}

EPCX_VERSION The event binding or task information. See topic EPCX - Event Processing

EPCX_SCHEMA__VERSION Context Container in the CICS Information Center for their definitions.
EPCX_SCHEMA _RELEASE

EPCX EVENT BINDING {EPCX_BUSINESSEVENT} Token is replaced with the business event name.
EPCX CS_ NAME

EPCX EBUSERTAG
EPCX_BUSINESSEVENT
EPCX NETQUAL
EPCX_APPLID

EPCX TRANID
EPCX_USERID

EPCX ABSTIME
EPCX_EVENT TYPE
EPCX PROGRAM

EPCX RESP
EPCXiUOWID

EPAP_VERSION Contents of the specified field from EP adapter configuration. Refer to topic EPAP
EPAP_ADAPTER NAME - Event Processing Adaptparm Container in the CICS Information Center for their

EPAP_RECOVER definitions

{EPAP RECOVER}

Additional tokens available with LINK or START commands

The following tokens are only available when the SupportPac is started by the LINK
or START CHANNEL commands.

Token Usage and examples

TASK_TRANID The current task transaction ID.

{TASK _TRANID}

TASK_USERID The current task user ID.

{TASK USERID}

TASK_PROGRAM  The current program name.
{TASK PROGRAM}

TASK_NUMBER The current task number.

{TASK_NUMBER}

REGION_SYSID  The CICS region system ID.

{REGION SYSID}

REGION_APPLID The CICS region application ID.

{REGION APPLID)}

Examples using tokens for email attachments

You can add one or more properties to an email as attachments. Email clients can
typically preview and save attachments, or start other applications to handle them.
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Tokens

Tokens can be used in combination to specify the attachment contents, name and
mime type.

Examples of how to use tokens to add a property as an attachment:

Attach a file from zFS as a picture with the default name picture.png
and default MIME type image/png:

picture={file=/path/picture.png:binary}

Attach a terms and conditions PDF with the default MIME type
application/pdf and specify the name Terms and
Conditions.pdf:

terms={name=Terms and conditions.pdf} {file=/path/terms
.pdf:binary}

Attach a zip file YourDocuments. zip that contains a PDF and picture:
picture={file=/path/picture.png:binary}

terms={file=/path/terms.pdf:binary}
attach={zip=YourDocuments.zip:include=picture, terms}

Attach an invoice PDF created from the XML in the property and a
stylesheet:

myXSLT={file=/path/stylesheet.xslt:encoding=UTF-8}
invoice={name=Invoice.pdf} {mime=text/xml:to=applicatio

n/pdf:xslt=myXSLT}<?xml version="1.0" encoding="UTF-8"
?> <name>Joe Bloggs</name>
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Chapter 10. Troubleshooting

Use the following checklist to diagnose problems using the SupportPac.

Troubleshooting

1.

The SupportPac will abend CA1Y if it is started as a custom event adapter
and the event could not be emitted.

Ensure the resources defined when the SupportPac was installed are
correct, installed and enabled:

JVMSERVER named DFH$JVMS

TRANSACTION named CA1Y

PROGRAM named CA1Y

BUNDLE named CA1YEXAM for the examples - optional
BUNDLE named FOP for Apache FOP - optional

If starting the SupportPac with events, ensure that CICS event processing
is enabled and the event is being captured. To view the status of event
processing and the number of captured events, use the CICS Explorer
views available in the CICS SM perspective, under menu Operations —
Event Processing.

Review the contents of the JVM server stderr and stdout files.

For example if the mail server could not be reached there will likely be
javax.mail.MessagingException entries with further exception information
and a backtrace.

Review the contents of the OSGi framework log files, as described in
Diagnostics for Java.

Verify the JavaMail API bundle mail.jar or javax.mail.jar and
SupportPac bundle com. ibm.cics.caly 1.7.0.jar are installed.

Enable Java Logging for the package com.ibm.cics.caly. For example,
add the following line to the JVM server profile to log all message levels
using the ConsoleHandler that directs logging output to stderr.

Note the log is written using the JVM server default file encoding that may
be an EBCDIC codepage. If a character cannot be converted the
codepage substitution character will be used instead.

Djava.util.logging.config.file=/usr/lpp/cal
y/examples/logging.properties

After making changes to the JVM server profile you will need to disable
and enable the JVMSERVER, then attempt to resend the email.

If there are issues transforming XML using an XML stylesheet, check the
output from JAXP by adding the following to the JVM server profile, disable
and enable the JVMSERVER, then attempt to resend the email:

-Djaxp.debug=1

Ensure the TCP/IP stack on the LPAR in which the SupportPac is running
is able to reach the target SMTP server and there are no firewalls that
block access. For example, log onto z/OS with telnet and use:

traceroute <mail server hostname>

Once the SupportPac prepares the email it uses the JavaMail API to
interact with the mail server. You may therefore find useful diagnostic
information in the JAVAMAIL API FAQ.
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10.
11.

12.

13.

14.
15.

Check the email is not being removed as junk by your email provider.

If the Java stderr contains javax.mail .MessagingException:

Could not connect to SMTP host: localhost, port: 25 then
it is likely the mail server properties are not defined or being imported
correctly. Check the encoding of the file is the same as that used on the file
token.

For example, if the file is stored at
/usr/lpp/caly/examples/emailServer.properties in EBCDIC
codepage 1047, the event adapter configuration should import the
properties with;

import={file:/usr/lpp/cal
y/examples/emailServer.properties:encoding=Cpl047}

If the Java stderr contains java.io.FileNotFoundException: File
'/usr/lpp/caly/examples/emailServer.properties' does not

exist then it is likely the file does not exist, or the file or directory
permissions are not set correctly. Note that the directory needs to have
execute bit on for files to be read.

Check the site SupportPac CA1Y for later versions that may contain fixes
to your issue.

Email the SupportPac author for guidance — see Feedback on page 8.

If you are having issues creating a Java regular expression, as used in the
property token.regex and tokens htmitable and texttable, you may find site
http://www.regexplanet.com/advanced/javal/index.html useful to try and
evaluate expressions.
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Chapter 11. Notices

The provisions set out in the following two paragraphs do not apply in the United
Kingdom or any other country where such provisions are inconsistent with local
law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY, OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore this statement may not apply to
you.

Information contained and techniques described in this publication have not been
submitted to any formal IBM test and are distributed on an "AS IS" basis.

The use or implementation of any information contained and/or of any technique
described in this document is the user's responsibility and depends on the user's
ability to evaluate and integrate the information and/or technique into the user's
operational environment. While IBM has reviewed each item for accuracy in a
specific situation, IBM offers no guarantee or warranty that the same or similar
results will be obtained elsewhere. Users attempting to adapt any technique
described in this document to their own environments do so at their own risk.

The information contained in this publication could include technical inaccuracies or
typographical errors.

Changes are periodically made to the information contained herein; these changes
will be incorporated in new editions of the publication. IBM may make
improvements and/or changes in the product(s) and/or the program(s) described in
this publication at any time without notice.

Any reference in this publication to an IBM licensed program or another IBM
product is not intended to state or imply that only IBM's program or other product
may be used. Any functionally equivalent program that does not infringe applicable
intellectual property rights may be used instead of the referenced IBM licensed
program or other IBM product.

The user is responsible for evaluating and verifying the operation of the material
supplied in conjunction with this publication in conjunction with other products,
except those expressly designated by IBM.

International Business Machines Corporation may have patents or pending patent
applications covering subject-matter described in this document. The furnishing of
this document does not give you any license to any such patent. You can send
license inquiries, in writing, to:

The IBM Director of Licensing

International Business Machines Corporation
North Castle Drive

Armonk, NY 10504-1785

U.S.A
License
The international license agreement for the SupportPac is available as a set of
language-specific text files in the directory 1icenses in the CA1Y.zip file. The
SupportPac is provided “as-is” and does not include defect correction.
Trademarks

Notices

The following terms are trademarks of International Business Machines
Corporation in the United States, or other countries, or both:
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IBM CICS MVS
z/OS System z WebSphere

Java, JavaMail and all Java-based trademarks and logos are trademarks of Sun
Microsystems, Inc. in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Other product and service names might be trademarks of IBM or other companies.
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